Table of Contents

Microsoft HoloLens

HoloLens in the enterprise: requirements and FAQ
Set up HoloLens
Unlock Windows Holographic for Business features
Enroll HoloLens in MDM
Set up HoloLens in kiosk mode
Configure HoloLens using a provisioning package
Install apps on HoloLens
Change history for Microsoft HoloLens documentation
Microsoft HoloLens is the first fully self-contained holographic computer running Windows 10.

Microsoft HoloLens is available in the Development Edition, which runs Windows Holographic (an edition of Windows 10 designed for HoloLens), and in the Commercial Suite, which runs Windows Holographic for Business when you apply the Enterprise license file to the device.

In this section

<table>
<thead>
<tr>
<th>TOPIC</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>HoloLens in the enterprise: requirements</td>
<td>Lists requirements for general use, Wi-Fi, and device management</td>
</tr>
<tr>
<td>Set up HoloLens</td>
<td>How to set up HoloLens for the first time</td>
</tr>
<tr>
<td>Unlock Windows Holographic for Business features</td>
<td>How to upgrade your Development Edition HoloLens to Windows Holographic for Business</td>
</tr>
<tr>
<td>Enroll HoloLens in MDM</td>
<td>Manage multiple HoloLens devices simultaneously using solutions like Microsoft Intune</td>
</tr>
<tr>
<td>Set up HoloLens in kiosk mode</td>
<td>Enable kiosk mode for HoloLens, which limits the user’s ability to launch new apps or change the running app</td>
</tr>
<tr>
<td>Configure HoloLens using a provisioning package</td>
<td>Provisioning packages make it easy for IT administrators to configure HoloLens devices without imaging</td>
</tr>
<tr>
<td>Install apps on HoloLens</td>
<td>Use Microsoft Store for Business, mobile device management (MDM), or the Windows Device Portal to install apps on HoloLens</td>
</tr>
</tbody>
</table>

Related resources

- Help for using HoloLens
- Documentation for Holographic app development
- HoloLens Commercial Suite
- HoloLens release notes
Microsoft HoloLens in the enterprise: requirements and FAQ

When you develop for HoloLens, there are system requirements and tools that you need. In an enterprise environment, there are also a few requirements to use and manage HoloLens which are listed below.

Requirements

General use
- Microsoft account or Azure Active Directory (Azure AD) account
- Wi-Fi network to set up HoloLens

**NOTE**
After you set up HoloLens, you can use it offline with some limitations.

Supported wireless network EAP methods
- PEAP-MS-CHAPv2
- PEAP-TLS
- TLS
- TTLS-CHAP
- TTLS-CHAPv2
- TTLS-MS-CHAPv2
- TTLS-PAP
- TTLS-TLS

Device management
- Users have Azure AD accounts with Intune license assigned
- Wi-Fi network
- Intune or a 3rd party mobile device management (MDM) provider that uses Microsoft MDM APIs

Upgrade to Windows Holographic for Business
- HoloLens Enterprise license XML file

FAQ for HoloLens

*Is Windows Hello for Business supported on HoloLens?*
Hello for Business (using a PIN to sign in) is supported for HoloLens. It must be configured using MDM.

*Does the type of account change the sign-in behavior?*
Yes, the behavior for the type of account impacts the sign-in behavior. If you apply policies for sign-in, the policy is always respected. If no policy for sign-in is applied, these are the default behaviors for each account type.

- Microsoft account: signs in automatically
- Local account: always asks for password, not configurable by Settings
- Azure AD: asks for password by default; configurable by Settings to no longer ask for password.
**NOTE**

Inactivity timers are currently not supported, which means that the `AllowIdleReturnWithoutPassword` policy is respected only when the device goes into StandBy.

**How do I remove a HoloLens device from the Intune dashboard?**

You cannot unenroll HoloLens from Intune remotely. If the administrator unenrolls the device using MDM, the device will age out of the Intune dashboard.

**Related resources**

- Getting started with Azure Active Directory Premium
- Get started with Intune
- Enroll devices for management in Intune
- Azure AD editions
Before you get started setting up your HoloLens, make sure you have a Wi-Fi network and a Microsoft account or an Azure Active Directory (Azure AD) account.

Network connectivity requirements

The first time you use your HoloLens, you’ll be guided through connecting to a Wi-Fi network. You need to connect HoloLens to a Wi-Fi network with Internet connectivity so that the user account can be authenticated.

- It can be an open Wi-Fi or password-protected Wi-Fi network.
- The Wi-Fi network cannot require you to navigate to a webpage to connect.
- The Wi-Fi network cannot require certificates to connect.
- The Wi-Fi network does not need to provide access to enterprise resources or intranet sites.

HoloLens setup

The HoloLens setup process combines a quick tutorial on using HoloLens with the steps needed to connect to the network and add an account.

1. Be sure your HoloLens is charged, then adjust it for a comfortable fit.
2. Turn on HoloLens. You will be guided through a calibration procedure and how to perform the gestures that you will use to operate HoloLens.
3. Next, you’ll be guided through connecting to a Wi-Fi network.
4. After HoloLens connects to the Wi-Fi network, you select between My work or school owns it and I own it.
   - When you choose My work or school owns it, you sign in with an Azure AD account. If your organization uses Azure AD Premium and has configured automatic MDM enrollment, HoloLens will be enrolled in MDM. If your organization does not use Azure AD Premium, automatic MDM enrollment isn’t available, so you will need to enroll HoloLens in device management manually.
     a. Enter your organizational account.
     b. Accept privacy statement.
     c. Sign in using your Azure AD credentials. This may redirect to your organization’s sign-in page.
     d. Continue with device setup.
   - When you choose I own it, you sign in with a Microsoft account. After setup is complete, you can enroll HoloLens in device management manually.
     a. Enter your Microsoft account.
     b. Enter your password. If your Microsoft account requires two-step verification (2FA), complete the verification process.
5. The device sets your time zone based on information obtained from the Wi-Fi network.
6. Next, you learn how to perform the bloom gesture and how to select and place the Start screen. After you place the Start screen, setup is complete and you can begin using HoloLens.
Unlock Windows Holographic for Business features

7/28/2017 • 4 min to read • Edit Online

Microsoft HoloLens is available in the Development Edition, which runs Windows Holographic (an edition of Windows 10 designed for HoloLens), and in the Commercial Suite, which provides extra features designed for business.

When you purchase the Commercial Suite, you receive a license that upgrades Windows Holographic to Windows Holographic for Business. This license can be applied to the device either through the organization’s mobile device management (MDM) provider or a provisioning package.

**TIP**
You can tell that the HoloLens has been upgraded to the business edition in Settings > Network & Internet. The VPN option is only available in Windows Holographic for Business.

Edition upgrade using MDM

The enterprise license can be applied by any MDM provider that supports the WindowsLicensing configuration service provider (CSP). The latest version of the Microsoft MDM API will support WindowsLicensing CSP.

**Overview**

1. Set up the edition upgrade policy.
2. Deploy the policy.
3. Enroll the device through the Settings app.

The procedures in this topic use Microsoft Intune as an example. On other MDM providers, the specific steps for setting up and deploying the policy might vary.

**Set up the Edition Upgrade policy**

1. Sign into the Intune Dashboard with your Intune admin account.
2. In the Policy workspace, select Configuration Policies and then Add.
3. In **Create a new policy**, select the **Edition Upgrade Policy (Windows 10 Holographic and later template)**, and click **Create Policy**.

4. Enter a name for the policy.

5. In the **Edition Upgrade** section, in **License File**, browse to and select the XML license file that was provided when you purchased the Commercial Suite.

6. Click **Save Policy**.

**Deploy the Edition Upgrade policy**

Next, you will assign the Edition Upgrade policy to selected groups.

1. In the **Policy workspace**, select the Edition upgrade policy that you created, and then choose **Manage Deployment**.
2. In the Manage Deployment dialog box, select one or more groups to which you want to deploy the policy, and then choose Add > OK.

When these users enroll their devices in MDM, the Edition Upgrade policy will be applied.

For more information about groups, see Use groups to manage users and devices in Microsoft Intune.

**Edition upgrade using a provisioning package**

Provisioning packages are files created by the Windows Imaging and Configuration Designer (ICD) tool that apply a specified configuration to a device.

**Create a provisioning package that upgrades the Windows Holographic edition**

1. Create a provisioning package for HoloLens.


3. Browse to and select the XML license file that was provided when you purchased the Commercial Suite.

   **NOTE**
   You can configure additional settings in the provisioning package.

4. On the File menu, click Save.

5. Read the warning that project files may contain sensitive information, and click OK.

   **IMPORTANT**
   When you build a provisioning package, you may include sensitive information in the project files and in the provisioning package (.ppkg) file. Although you have the option to encrypt the .ppkg file, project files are not encrypted. You should store the project files in a secure location and delete the project files when they are no longer needed.

6. On the Export menu, click Provisioning package.

7. Change Owner to IT Admin, which will set the precedence of this provisioning package higher than provisioning packages applied to this device from other sources, and then select Next.

8. Set a value for Package Version.

   **TIP**
   You can make changes to existing packages and change the version number to update previously applied packages.

10. Click Next to specify the output location where you want the provisioning package to go once it’s built. By default, Windows ICD uses the project folder as the output location.

   Optionally, you can click Browse to change the default output location.

11. Click Next.

12. Click Build to start building the package. The project information is displayed in the build page and the progress bar indicates the build status.

13. When the build completes, click Finish.

Apply the provisioning package to HoloLens

1. Connect the device via USB to a PC and start the device, but do not continue past the fit page of the initial setup experience (the first page with the blue box).


3. HoloLens will show up as a device in File Explorer on the PC.

4. In File Explorer, drag and drop the provisioning package (.ppkg) onto the device storage.

5. Briefly press and release the Volume Down and Power buttons simultaneously again while on the fit page.

6. The device will ask you if you trust the package and would like to apply it. Confirm that you trust the package.

7. You will see whether the package was applied successfully or not. If it failed, you can fix your package and try again. If it succeeded, proceed with device setup.

NOTE

If the device was purchased before August 2016, you will need to sign into the device with a Microsoft account, get the latest OS update, and then reset the OS in order to apply the provisioning package.
You can manage multiple Microsoft HoloLens devices simultaneously using solutions like Microsoft Intune. You will be able to manage settings, select apps to install and set security configurations tailored to your organization’s need. See the configuration service providers (CSPs) that are supported in Windows Holographic and the policies supported by Windows Holographic for Business.

**NOTE**
Mobile device management (MDM), including the VPN, Bitlocker, and kiosk mode features, is only available when you upgrade to Windows Holographic for Business.

### Requirements

Your organization will need to have mobile device management (MDM) set up in order to manage HoloLens devices. Your MDM provider can be Microsoft Intune or a 3rd party provider that uses Microsoft MDM APIs.

### Auto-enrollment in MDM

If your organization uses Azure Active Directory (Azure AD) and an MDM solution that accepts an AAD token for authentication (currently, only supported in Microsoft Intune and AirWatch), your IT admin can configure Azure AD to automatically allow MDM enrollment after the user signs in with their Azure AD account. Learn how to configure Azure AD enrollment.

When auto-enrollment is enabled, no additional manual enrollment is needed. When the user signs in with an Azure AD account, the device is enrolled in MDM after completing the first-run experience.

### Enroll through Settings app

When the device is not enrolled in MDM during the first-run experience, the user can manually enroll the device with the organization’s MDM server using the Settings app.

1. Go to **Settings > Accounts > Work access**.

2. Select **Enroll into device management** and enter your organizational account. You will be redirected to your organization’s sign in page.

3. Upon successful authentication to the MDM server, a success message is shown.

Your device is now enrolled with your MDM server. The device will need to restart to acquire policies, certificates, and apps. The Settings app will now reflect that the device is enrolled in device management.
Set up HoloLens in kiosk mode

7/28/2017 • 1 min to read • Edit Online

Kiosk mode limits the user’s ability to launch new apps or change the running app. When kiosk mode is enabled for HoloLens, the bloom gesture and Cortana are disabled, and placed apps aren’t shown in the user’s surroundings.

1. Set up the HoloLens to use the Windows Device Portal. The Device Portal is a web server on your HoloLens that you can connect to from a web browser on your PC.

   **IMPORTANT**
   When you set up HoloLens to use the Device Portal, you must enable Developer Mode on the device. Developer Mode on a device that has been upgraded to Windows Holographic for Business enables side-loading of apps, which risks the installation of apps that have not been certified by the Microsoft Store. Administrators can block the ability to enable Developer Mode using the ApplicationManagement/AllowDeveloper Unlock setting in the Policy CSP. Learn more about Developer Mode.

2. On a PC, connect to the HoloLens using Wi-Fi or USB.

3. Create a user name and password if this is the first time you connect to the Windows Device Portal, or enter the user name and password that you previously set up.

   **TIP**
   If you see a certificate error in the browser, follow these troubleshooting steps.

4. In the Windows Device Portal, click Kiosk Mode.

   **NOTE**
   The kiosk mode option will be available if the device is enrolled in device management and has a license to upgrade to Windows Holographic for Business.

5. Select Enable Kiosk Mode, choose an app to run when the device starts, and click Save.
Configure HoloLens using a provisioning package

Windows provisioning makes it easy for IT administrators to configure end-user devices without imaging. The Windows Assessment and Deployment Kit (ADK) for Windows 10 includes the Windows Configuration Designer, a tool for configuring images and runtime settings which are then built into provisioning packages.

Some of the HoloLens configurations that you can apply in a provisioning package:

- Upgrade to Windows Holographic for Business
- Set up a local account
- Set up a Wi-Fi connection
- Apply certificates to the device

To install Windows Configuration Designer and create provisioning packages, you must install the Windows Assessment and Deployment Kit (ADK) for Windows 10 or install Windows Configuration Designer from the Microsoft Store.

When you run ADKsetup.exe for Windows 10, version 1607, select Configuration Designer from the Select the features you want to install dialog box.

![Select the features you want to install](image)

NOTE

In previous versions of the Windows 10 ADK, you had to install additional features for Windows Configuration Designer to run. Starting in version 1607, you can install Windows Configuration Designer without other ADK features.

Create a provisioning package for HoloLens
NOTE
Settings in a provisioning package will only be applied if the provisioning package includes an edition upgrade license to Windows Holographic for Business or if the device has already been upgraded to Windows Holographic for Business.

1. On the Windows Configuration Designer start page, select Advanced provisioning.

2. In the Enter project details window, specify a name for your project and the location for your project. Optionally, enter a brief description to describe your project.

3. Click Next.

4. In the Choose which settings to view and configure window, select Windows 10 Holographic, and then click Next.

5. Click Finish.

6. Expand Runtime settings and customize the package with any of the settings described below.

   IMPORTANT
   If you create a local account in the provisioning package, you must change the password using the Settings app every 42 days. If the password is not changed during that period, the account might be locked out and unable to sign in. If the user account is locked out, you must perform a full device recovery.

7. On the File menu, click Save.

8. Read the warning that project files may contain sensitive information, and click OK.

   IMPORTANT
   When you build a provisioning package, you may include sensitive information in the project files and in the provisioning package (.ppkg) file. Although you have the option to encrypt the .ppkg file, project files are not encrypted. You should store the project files in a secure location and delete the project files when they are no longer needed.


10. Change Owner to IT Admin, which will set the precedence of this provisioning package higher than provisioning packages applied to this device from other sources, and then select Next.

11. Set a value for Package Version.

   TIP
   You can make changes to existing packages and change the version number to update previously applied packages.

12. On the Select security details for the provisioning package, click Next.

13. Click Next to specify the output location where you want the provisioning package to go once it’s built. By default, Windows Configuration Designer uses the project folder as the output location. Optionally, you can click Browse to change the default output location.

14. Click Next.

15. Click Build to start building the package. The project information is displayed in the build page and the...
Apply a provisioning package to HoloLens

1. Connect the device via USB to a PC and start the device, but do not continue past the Fit page of OOBE (the first page with the blue box).


3. HoloLens will show up as a device in File Explorer on the PC.

4. In File Explorer, drag and drop the provisioning package (.ppkg) onto the device storage.

5. Briefly press and release the Volume Down and Power buttons simultaneously again while on the fit page.

6. The device will ask you if you trust the package and would like to apply it. Confirm that you trust the package.

7. You will see whether the package was applied successfully or not. If it failed, you can fix your package and try again. If it succeeded, proceed with OOBE.

**NOTE**

If the device was purchased before August 2016, you will need to sign into the device with a Microsoft account, get the latest OS update, and then reset the OS in order to apply the provisioning package.

What you can configure

Provisioning packages make use of configuration service providers (CSPs). If you’re not familiar with CSPs, see [Introduction to configuration service providers (CSPs) for IT pros](#).

In Windows Configuration Designer, when you create a provisioning package for Windows Holographic, the settings in Available customizations are based on CSPs that are supported in Windows Holographic. The following table describes settings that you might want to configure for HoloLens.
<table>
<thead>
<tr>
<th>SETTING</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accounts</td>
<td>Create a local account. HoloLens currently supports a single user only. Creating multiple local accounts in a provisioning package is not supported. <strong>IMPORTANT</strong> If you create a local account in the provisioning package, you must change the password using the Settings app every 42 days. If the password is not changed during that period, the account might be locked out and unable to sign in. If the user account is locked out, you must perform a full device recovery.</td>
</tr>
<tr>
<td>Certificates</td>
<td>Deploy a certificate to HoloLens.</td>
</tr>
<tr>
<td>ConnectivityProfiles</td>
<td>Deploy a Wi-Fi profile to HoloLens.</td>
</tr>
<tr>
<td>EditionUpgrade</td>
<td>Upgrade to Windows Holographic for Business.</td>
</tr>
<tr>
<td>Policies</td>
<td>Allow or prevent developer mode on HoloLens. Policies supported by Windows Holographic for Business</td>
</tr>
</tbody>
</table>

**NOTE**
App installation ([UniversalAppInstall](UniversalAppInstall)) using a provisioning package is not currently supported for HoloLens.
The recommended way to install Universal Windows Platform (UWP) apps on HoloLens is to use Microsoft Store for Business. You can make your own line-of-business application available through Microsoft Store for Business.

You can also deploy apps using your mobile device management (MDM) provider or use the Windows Device Portal to install apps, if you enable Developer Mode on the HoloLens device.

**IMPORTANT**

When you set up HoloLens to use the Device Portal, you must enable Developer Mode on the device. Developer Mode on a device that has been upgraded to Windows Holographic for Business enables side-loading of apps, which risks the installation of apps that have not been certified by the Microsoft Store. Administrators can block the ability to enable Developer Mode using the ApplicationManagement/AllowDeveloperUnlock setting in the Policy CSP. Learn more about Developer Mode.

---

**Use Microsoft Store for Business to deploy apps to HoloLens**

Microsoft Store for Business is a private Microsoft Store for your enterprise. People in your organization can open the Store app and select your private Store to install apps that you have made available to them.

![Contoso publishing Apps](image)

In your Microsoft Store for Business dashboard, you can also download apps to distribute to devices that aren’t connected to the Internet, plus add line-of-business (LOB) apps for distribution.

**Requirements**

- You need to be a global administrator for your Azure Active Directory (Azure AD) tenant.

**TIP**

You can create an Azure AD account and tenant as part of the Store for Business sign-up process.

- End users need Azure AD accounts when they access Store for Business content from Windows-based devices.

**Microsoft Store for Business process**

1. Sign up for Microsoft Store for Business.
2. Assign roles and permissions for managing your Store for Business.
3. (Optional) Configure Microsoft Store for Business to work with your MDM provider.
4. Get apps for your Store for Business.
5. Distribute apps to your employees.

### Install apps on HoloLens from Microsoft Store for Business

The method that you use to install an app from your Microsoft Store for Business on HoloLens depends on the distribution method that you choose.

<table>
<thead>
<tr>
<th>DISTRIBUTION METHOD</th>
<th>TO INSTALL ON HOLOLENS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Using private store</td>
<td>Open the Store app and select the tab for your organization to choose from available apps.</td>
</tr>
<tr>
<td>Using MDM</td>
<td>You can configure MDM to synchronize your Store for Business inventory.</td>
</tr>
</tbody>
</table>

### Use MDM to deploy apps to HoloLens

You can deploy UWP apps to HoloLens using your MDM provider. For Intune instructions, see [Deploy apps in Microsoft Intune](#).

Using Intune, you can also [monitor your app deployment](#).

### Use the Windows Device Portal to install apps on HoloLens.

1. **Set up the HoloLens to use the Windows Device Portal.** The Device Portal is a web server on your HoloLens that you can connect to from a web browser on your PC.
2. **On a PC, connect to the HoloLens using Wi-Fi or USB.**
3. **Create a user name and password** if this is the first time you connect to the Windows Device Portal, or enter the user name and password that you previously set up.

<table>
<thead>
<tr>
<th><strong>TIP</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>If you see a certificate error in the browser, follow these troubleshooting steps.</td>
</tr>
</tbody>
</table>

4. In the Windows Device Portal, click **Apps**.
5. In **Install app**, select an **app package** from a folder on your computer or network. If the app package requires additional software, click **Add dependency**.

6. In **Deploy**, click **Go** to deploy the app package and added dependencies to the connected HoloLens.
This topic lists new and updated topics in the Microsoft HoloLens documentation.

## May 2017

<table>
<thead>
<tr>
<th>NEW OR CHANGED TOPIC</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft HoloLens in the enterprise: requirements</td>
<td>Changed title to Microsoft HoloLens in the enterprise: requirements and FAQ, added questions and answers in new FAQ section</td>
</tr>
</tbody>
</table>

## January 2017

<table>
<thead>
<tr>
<th>NEW OR CHANGED TOPIC</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>All topics</td>
<td>Changed all references from Windows Holographic Enterprise to Windows Holographic for Business</td>
</tr>
</tbody>
</table>